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On-demand SciFinder training resources are available at CAS web site:  
http://www.cas.org/training/scifinder 

 



How to  Create a  
Substance Answer Set 

Types of Substance Searches 
On the Explore tab, under SUBSTANCES, 
you can search by any of the five options.  
 
Click Advanced Search to see criteria that 
you can add to a search to make it more 
specific: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• These search limiters are available as 

part of the Refine and Analyze functions, 
so you can also apply them later in your 
search process. 

Select among five search techniques to find substances  
Since substances can be described by multiple names or other characteristics, SciFinder gives you the flexibility to approach a substance search from different starting 

points, depending on your research needs. No matter how you begin, your results are from the CAS REGISTRYSM database, the  most trusted and comprehensive collection 

of publicly available chemical substances in the world. Refer to “How to … Work with Substance Answer Sets” for ways to evaluate the results and hone in on the most 

relevant answers. To learn more about using SciFinder, consult the online Help or visit www.cas.org/training/scifinder. 
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Tip 
If you are using the 
stand-alone drawing 
editor (available from 
www.cas.org), then 
click Import CXF to 
upload the structure. 



SELECT… IF YOU WANT TO RETRIEVE… 
Exact Search The specific structure as drawn in the 

query, including: 
x Stereoisomers 
x Salts and mixtures 
x Polymers with one exactly matching 

monomer 
x Isotopes 
x Tautomers 

Substructure Search The structure as drawn or as part of a 
larger molecule in which there is: 
x Substitution at open positions 
x Additional ring fusion 

Similarity Search 
(Queries cannot include 
variable groups, repeating 
groups, or variable 
attachment positions) 

Similar chemical structures containing: 
x Positional isomers 
x Different or fewer substituents 
x Different ring systems 

Select Chemical Structure (the default). 
 
Click the picture of the structure drawing 
window to launch the Structure Editor. 
 
Draw your structure. 
 
Specify the type of structure search. 
 
Click OK to transfer the structure and type 
of search to the search page.  
 

Continued 

 

Search by Chemical Structure  
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Tip 
To learn about structure 
drawing, refer to the 
online help or the 
“Introduction to the 
SciFinder Drawing Editor” 
tutorial on cas.org. 
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Click Search to retrieve the answers that 
meet your query requirements. 
 
For Similarity searches, after you click 
Search, you will see a Similarity Candidates 
window. To select the degree(s) of similarity 
for your answers, check the box(es) of 
interest. Then, click Get Substances. 
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Now what? 
After you click Search, SciFinder will retrieve the answers that meet your query requirements. To learn about working 
with the answers, please see the companion document titled, “How to… Work with a Substance Answer Set.” 

 
Tip 
Optional: Select Show precision analysis to include 
additional structure criteria in your search: 
Conventional Exact, Closely Associated Tautomers and 
Zwitterions, Loosely Associated Tautomers and 
Zwitterions, and Other.   
 
 
 
 
 
 
 
 

Precision Analysis Window (Unrelated Example) 
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To begin, click Markush. 
 
Click the picture of the structure drawing 
window to launch the Structure Editor. 
 
Draw your structure. 
 
Specify the type of structure search and 
then click OK to transfer the structure and 
type of search to the search page.  

B.  Search by Markush Structure 
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SELECT… IF YOU WANT TO 
RETRIEVE… 

Variable only at 
the specified 
positions 

Structures in which 
substitution is only 
allowed where it is 
specifically indicated by 
R-groups or other 
variable atom or bond 
features 

Substructure of 
more complex 
structures  

Structures in which 
substitution is allowed 
on all positions where it 
is not explicitly blocked 

Continued 

Search by Markush to find Markush structures in 
patents. You begin with a structure search and 
retrieve patent references that contain those 
Markush structures. 
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Click Search to retrieve the answers that 
meet your query requirements.  
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Now what? 
After you click Search, SciFinder will retrieve the answers which meet your query requirements. To learn about working 
with the answers, please see the companion document titled, “How to… Work with a Reference Answer Set.” 
 

Tip 
Markush searching is a 
great way to extend a 
structure search, especially 
if you did not find any 
substances with a structure 
search and are interested 
in patentability. 

SciFinder is useful for a preliminary patentability 
or freedom to operate search. For a thorough 
patentability search, consult a patent attorney or 
informational professional. 
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To begin, click Molecular Formula. 
 
Enter the molecular formula into the query 
box. 
 
Click Search. 
 

C.  Search by Molecular Formula  
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Molecular Formula Query Guidelines 

• Specify the full molecular formula, including the hydrogens (Hill Order not required) 

• Separate each element symbol and its count with a space 

• Capitalize the first character for multi-character symbols, and use lower case for the second 
letter (i.e., Si, Cl, Fe) 

• You can search two isotopes: D = deuterium and T= tritium 

Now what? 
Molecular Formula searches often retrieve 
many isomeric substances and it is necessary 
to narrow answers. To learn about working 
with the answers, please see the companion 
document titled, “How to… Work with a 
Substance Answer Set.” 

Tip 
Click a       to access context-specific online 
help. If you click it next to Molecular 
Formula, the help message provides many 
examples about how to search Molecular 
Formulas for polymers, salts, and structure 
repeating units. 

Copyright © 2013. American Chemical Society (ACS). All rights reserved. 
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To begin, click Property. 
 
Click the appropriate radio button to select 
either Experimental or Predicted property. 
Next, click the drop-down menu and select 
the specific type of property you want to 
search. 
 
Enter the Value or Range. 
 
Click Search to retrieve the answers that 
meet your query requirements. 
 
 

D. Search by Property  
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Now what? 
After you click Search, SciFinder will retrieve the answers which meet your query requirements. To learn about working 
with the answers, please see the companion document titled, “How to… Work with a Substance Answer Set.” 
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Tip 
If your property search results in a large 
answer set, you can narrow it by specifying 
additional criteria using Refine or Analyze. 

Copyright © 2013. American Chemical Society (ACS). All rights reserved. 
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To begin, click Substance Identifier. 
 
Enter up to 25 substance identifiers, one 
per line, in the query box. 
• A substance identifier can be a CAS 

Registry Number® or a chemical name. 
• Simple chemical names, trade names, 

abbreviations and common names often 
result in relevant answers. 

 
Click Search to retrieve the answers which 
meet your query requirements. 
 

E. Search by Substance Identifier 
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Now what? 
After you click Search, SciFinder will retrieve the answers which meet your query requirements. To learn about 
working with the answers, please see the companion document titled, “How to… Work with a Substance Answer Set.” 
 

Tip 
For complex, systematic names such as 
some IUPAC names, consider searching by 
the chemical structure.  It is often easier to 
match a structure rather than all of the 
chemical nomenclature and punctuation 
exactly as it is entered into the database. 

Copyright © 2013. American Chemical Society (ACS). All rights reserved. 
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Start a new references, substances or reactions search. 
 
Access Saved Answer Sets, Keep Me Posted automated alert results, and your search History.  
 
Open the SciPlanner interactive workspace where you can organize your reference, substance 
and reaction search results. 
 
 
 
 

Access Preferences and SciFinder Help 
options: Help, Training, What’s New, and 
Contact Us. 
 
 

Manage Your Searching 

CAS Customer Care Center 
Phone:  800-753-4227 (North America) Fax: 614-447-3751 
 614-447-3700 (Worldwide)    E-mail: help@cas.org 
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Tip: Other Ways to Create a Substance Answer Set 
• You can also create a substance answer set by starting with a reference search. After you get a reference answer set, click the “Get 

Substances” icon at the top of the page. 
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How to  Work with a 
Substance Answer Set 

Substance Search Results 
Exact and substructure 
answer sets are automatically 
sorted by relevance. Click the 
drop-down arrow to select 
another sort option. 
 
 
 
 
 
• The blue arrow indicates 

that the results are sorted 
from most to least 
relevant. Click the arrow to 
reverse the sort order. 

 

The total number of retrieved 
substances and the number 
selected are displayed. 
• Click the box to the left of 

an answer number to 
select it. 

• Click the drop-down arrow 
for options related to 
selected answers. 

Continued 

 

Easily identify and isolate substances of interest 
Quickly retrieve relevant information from the world’s largest, publicly available substance database. This guide provides an overview of some of the sort, refine, and 

analyze tools for confidently evaluating and narrowing even a large answer set. From there, two clicks retrieve references or reactions associated with your substance of 

interest. For more detailed information and additional training resources, consult the online Help or visit www.cas.org/training/scifinder. 
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Tip 
Default sort 
options vary 
depending on the 
type of search 
conducted. 
Molecular formula, 
property and 
substance 
identification 
searches are 
sorted by CAS 
Registry Number®. 
Similarity search 
results are sorted 
by similarity score. 
Markush search 
results are sorted 
from the newest to 
oldest reference. 
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Specify the number of 
answers displayed per page 
(15, 20, 25 or 50). To the 
right of View, select the 
number of columns that are 
displayed. 
 

Use the page controls to 
navigate through your 
answer set. 
 
Mouse over a substance to 
access additional substance 
information and tools. 
• Click the magnifying glass 

icon to launch the Quick 
View, a separate window 
that summarizes data 
about the substance. 
• Close the Quick View 

window to return to 
the active session. 

• Click the double blue 
arrow to access the 
additional search and 
export options shown 
here. 
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Each answer includes: 
• A Substance Detail link (see page 3) and the CAS Registry NumberTM     
• Active icons indicate the availability of: 

• References for the substance Reaction data 
• Chemical supplier information Regulated chemical list data 

• The chemical structure; the part that matches your query is red 
• The molecular formula  
• The CA Index Name (useful for government documents) 
• Links to Experimental Properties and Spectra, when available 

Copyright © 2013. American Chemical Society (ACS). All rights reserved. 
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Tip 
Whenever you see a 
structure in SciFinder, you 
can mouse over it to access 
the double blue arrows. Click 
the arrows to see options for 
extending your search. 



Substance Detail 
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Tip 
CAS Roles indicate the function of a substance in 
the document. CAS Analysts have been applying 
the roles as part of the indexing process since 
1967. The Preparation role goes back to 1907. 

3 

The blue box contains the CAS Registry 
Number, molecular formula, CA Index 
Name, and other names for this substance 
that CAS analysts found in the literature. 
The structure is to the right of the blue box; 
the hit structure is highlighted in red. 
 
The number of references for this 
substance is also a link to those references. 
• Subsets of the references such as 

Preparation or Patents are also links. 
• Click a checkmark for more specific 

subsets such as Preparation information 
from Patents. 

 
Click a Predicted Properties link, such as 
Lipinski, to quickly access that part of the 
predicted properties table. 

 
Experimental Properties are reported from 
specific references. 
• A blue number in the Note column 

indicates that the reference is available 
in SciFinder. Click the number or the link 
below the table to see the bibliographic 
information. 

• Alternatively, click the magnifying glass 
beside the reference to display the 
bibliographic information in a separate 
window (the Quick View). 

The Substance Detail page summarizes the 
available information for a substance. 

Copyright © 2013. American Chemical Society (ACS). All rights reserved. 
This material is provided solely for the educational use of customers of Chemical Abstracts Service (CAS), a division of the ACS. Please provide attribution to ACS. 
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Click the Analyze tab. By 
default, the answer set is 
analyzed by Substance Role. 
 
Click the drop-down arrow 
to see the available Analyze 
by: options.  
 
Click Show More to see 
additional data, when 
available, or to select more 
than one analysis subset. 
• Click the box to the left of 

a subset to select it. 
 
 

Evaluate Answers with Analysis Options 
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Tip 
After you select Show More, 
you can Sort by either 
Frequency (the default) or 
Natural Order (alphanumeric 
order).  
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 Click an Analyze bar to 
display that subset of 
answers. In this example, 
the answer set has been 
analyzed by Bioactivity 
Indicators and Respiratory 
system agents (all). 
• The analysis bar turns 

yellow. Other bars can 
also turn completely or 
partly yellow to indicate 
that substances from 
the selected bar are  
also present in other 
subsets.  

 
The yellow status bar 
indicates the answers that 
are currently displayed. 
• Click Keep Analysis to 

make these answers 
your new answer set. 

• Click Clear Analysis to 
return to your original 
answer set. 

Narrow an Answer Set after Analysis 
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Tip 
• Bioactivity Indicators are a predefined set of bioactivity terms for which 

relationships have been identified between substances in the CAS REGISTRYSM 
database and documents in the CAplusSM database. 

• Target Indicators are a predefined set of protein, enzyme, and other target terms 
for which relationships have been identified between substances in the  CAS 
REGISTRY database and documents in the CAplus database. 
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Click the Refine tab and 
select a Refine by: option by 
clicking the radio button.  
 
Specify additional criteria 
below the refine options. 
 
Click Refine. 

Narrow an Answer Set with Refine Options 
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Tip 
To Refine by Chemical Structure, click the 
thumbnail to re-open the Structure Editor.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Modify the structure and click OK. The 
modified structure is then displayed in the 
thumbnail on the Refine tab. 



Access Preferences and SciFinder Help options: Help, Training, What’s New and Contact Us. 
 
Click the Explore drop-down arrow to start a new references, substances or reactions search. 
 
Click the Saved Searches drop-down arrow to access Saved Answer Sets, Keep Me Posted 
answer sets and your search History. 
 
Click SciPlanner to open the SciPlanner workspace.  
• It is an interactive window where you can store and organize reference, substance and 

reaction search results.  
 
Click Save, Print or Export to open a dialog window and initiate each of these processes.  
• See “How to… Print, Save and Export” for more information. 
 
The breadcrumb trail shows each step in your current search history. Mouse over a step to 
see more information about it. Click a step to return to that part of the search. 
 
Click Get Substances to retrieve substances for part or all of your answer set.  
 
 
 
 

Click Get Reactions to retrieve reactions for 
part or all of your answer set. 
 
Click Get Commercial Sources to retrieve 
suppliers for part or all of your substances. 
 
Click the Tools drop-down arrow to combine 
this answer set with a previously saved 
answer set (Combine Answer Sets). 
 
Create Keep Me Posted Alert, when active, 
allows you to create an automated alert 
based on the current search strategy.  
 
Click Send to SciPlanner to send selected 
answers to the SciPlanner workspace. 
• Use it to gather information for a project, 

create a report or export research to 
share with colleagues.  

 

Manage Your Searching 

CAS Customer Care Center 
Phone:  800-753-4227 (North America) Fax: 614-447-3751 
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How to   Find  
Commercial Sources 

Find Commercial Sources 

Select Commercial Sources from the Tools 
menu. 
 
Click the Commercial Sources icon (red 
beaker with a yellow price tag). 
 
Select Get Commercial Sources in the 
substance context menu. 
 
 

Need a Source for a Reagent? Let SciFinder® Help Identify Suppliers 

Find your substance and then find sources from which to purchase it – all from within SciFinder. You can designate suppliers as preferred or non-preferred, and in many 

cases link directly to pricing and availability information from a supplier.  For additional training resources, consult the online Help or visit www.cas.org/training/scifinder. 

 

1 

2 

3 

Tip 
Mouse over the structure and click the 
double blue arrow to see the substance 
context menu. 

To find commercial sources for a substance, you 
can do any of the following: 
 
 

3 



 
Click the drop-down arrow to select a 
different Sort by option. Click the blue 
arrow to reverse the order. 
 
 
 
 
 
Click a company’s name to see the Source 
Detail display.  
 
The supplier’s status is shown in the lower 
right. Unclassified is the default.  
• Click the drop-down arrow to select a 

different status: Preferred or  
Non Preferred. 
 
 
 

After you designate a source as Preferred 
or Non-Preferred, subsequent commercial 
source displays will indicate that status and 
the sort order default becomes Supplier 
Preference. 
 
 
 

 

See Supplier Information 
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SciFinder returns a list of companies that sell the 
substance. By default, they are sorted by Catalog 
Name.   
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Click Preferences in the upper right of the 
any SciFinder window. 
 
In the Preferences window, click Edit 
supplier preferences. 
 
A list of your Preferred and Non-Preferred 
Suppliers is displayed in the window. 
• To remove a supplier from the preferred 

list, click the       icon. 
• To edit an existing supplier (e.g., 

changing the designated status), click 
Add/Edit Suppliers.   

 
To add a Supplier Name, type the name in 
the text box and click Find.  
• Supplier names appear below the text 

box.  
 
Click the drop-down arrow to change the 
Status of a new or existing supplier. 
• After you select a Status, the Save 

button becomes active. 
 
Click Save to keep the changes. 
 

Manage Preferred Suppliers 
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In Preferences, you can manage supplier 
information. 
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After you create a list of preferred suppliers, they 
will be displayed at the top of subsequent answer 
sets and will be the default setting for Sort and 
Analyze.  
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To see Pricing & Availability information, 
use either Sort or Analyze by to identify 
suppliers who make pricing information 
available online.  
 
Click the Pricing & Availability link to 
access the supplier’s website. 
 
 
 

Check Pricing and Availability  
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Preferred suppliers are displayed at the top of 
answer sets and are the default setting for Sort 
and Analyze.  

Tip 
Some suppliers require you to create a 
login ID before they give you access to 
the information. 
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How to  Create a 
Reaction Answer Set 

Begin a Reaction Search 
To begin, go to the left navigation pane and  
click Reaction Structure. 
 
Click the picture of the reaction drawing 
window to launch the Reaction Editor. 
 

Find all relevant reactions based on criteria you specify 
Search the world’s largest, publicly available reaction database and quickly find highly relevant results, no matter the size of your answer set. This How to 

Guide explains a variety of ways to design your reaction search.  Refer to “How to… Work with a Reaction Answer Set” to learn about tools and techniques 

to easily sort, organize and narrow your results and find the most relevant answers. For more training resources, consult the online Help or visit 

www.cas.org/training/scifinder. 
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Tip 
Click       to access context-specific 
online help. 

Tip 
If you are using the stand-alone 
drawing editor (available from 
www.cas.org), then click Import 
CXF to upload the structure. 



Draw your reaction.  
 
Learn about drawing in the Reaction Editor 
with the following tutorials, available in the 
online SciFinder Help: 
• “Introduction to the SciFinder Drawing 

Editor” 
• “Introduction to Reaction Searching” 
 
Select the type of reaction search that you 
want to conduct. 
 
 
 
 
 
 
 
 
 
 
 
Click OK to transfer the reaction and type 
of search to the search page. 

Draw the Reaction 
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SELECT… IF YOU WANT TO… 

Variable only at 
the specified 
positions 

Prohibit substitution at all 
atoms (except variables and 
R-groups) and prohibit 
additional ring fusion. 

Substructure of 
more complex 
structures 

Allow additional 
substitution and ring fusion. 
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Tip on Stereo Searching 
CAS scientists apply structure data to a record by reporting the information in the original document. If no stereo is identified, then the 
molecule is listed as a “flat” (2-dimensional) structure. If you search stereo bonds, you can miss relevant data that was listed in the literature 
only in a 2-dimensional format, whereas searching the flat structure will retrieve both 2-dimensional and 3-dimensional (stereo) structures. 

Tip 
Use a Hydrogen, H, or a shortcut 
structure, such as NO2 to block 
substitution at a site.  

1 
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Search the Reaction 

3 

Tip 
The limiters are available as part of the 
Refine and Analyze functions, so it is often 
advantageous to start with a broad search 
and narrow the answer set later.  

Now what? 
After you click Search, SciFinder will retrieve the 
answers which meet your query requirements. To 
learn about working with the answers, please see 
the companion document titled, “How to… Work 
with Reaction Answer Sets.” 
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When you click OK in the Reaction Editor, your 
reaction and Search type are transferred to the 
reaction search page.   

(optional) Click Advanced Search to see 
additional search options. 
 
(optional) Select limiters, such as Number 
of Steps, to further restrict your search. 
 
Click Search. 
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After you get a reference 
or substance answer  
set, click Get Reactions on 
the toolbar. 

 
After you get a substance 
answer set, mouse over a  
substance until a blue box 
appears around it. Click the  
double blue arrows in the 
upper right, and then 
select either Synthesize 
this… or Get Reactions 
where Substance is a > and 
select the reaction role for 
the substance. 
 

Other Ways to Create a Reaction Answer Set 
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You can also create a reaction 
answer set by starting with 
either reference or substance 
answers.  
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Start a new References, Substances or Reactions search. 
 
Access Saved Answer Sets, Keep Me Posted automated alert results, and your search 
History.  
 
Open the SciPlanner interactive workspace where you can organize your reference, 
substance and reaction search results. 
 
The breadcrumb trail shows each step in your current search history. Hover over a step to 
see more information about it. Click a step to return to that part of your search. 
 
 
 

Click Preferences to customize your search 
options. 
 
Click the SciFinder Help drop-down arrow 
to access online Help, Training, What’s 
New and Contact Us. 
 
Click Save, Print or Export to open a dialog 
window and initiate these procedures.  

Manage Your Searching 

CAS Customer Care Center 
Phone:  800-753-4227 (North America) Fax: 614-447-3751 
 614-447-3700 (Worldwide)    E-mail: help@cas.org 
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Now what? 
To learn about working with the reaction answer set, please see the 
companion document titled, “How to… Work with Reaction Answer Sets.” 



How to  Work with a  
Reaction Answer Set 

Reaction Search Results 
By default, answers are 
sorted from most to least 
relevant. 
• Click the drop-down 

arrow to select other 
sorting criteria. 

• Click the blue arrow to 
reverse the sort order. 
 

Here, the reaction schema 
and the Overview are 
displayed, as indicated by 
the benzene ring with the 
rectangle under it.  
• Click the benzene ring 

to see only the reaction 
schema. 
 

Hit structures are red.  
• Click the red flask below 

a structure to see 
supplier catalog 
information for that 
substance. 
 

Continued 
 

Find all relevant reactions based on criteria you specify 
Quickly retrieve relevant information from the world’s largest, publicly available reaction database. This guide provides an overview of the tools in SciFinder 

that you can use to evaluate and narrow even a large answer set. From there, a single click retrieves references associated with your reaction(s) of interest. 

For more detailed information and additional training resources, consult the online Help or visit www.cas.org/training/scifinder. 
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Tip: See the 
Newest Records 
First 
Accession 
Numbers start 
with the year 
that a record is 
added to the 
database and 
then are 
numbered 
sequentially (i.e., 
2012:967458). 
Sort by this 
option to see the 
most recently 
added records 
first. 

3 

1 

3 

2 



Click the box beside an 
answer number to select it. 
You can work with selected 
items several ways, such as 
saving them or getting 
references for them. 
 
Mouse over a structure to 
access additional substance 
information and search 
options.  

• Click the blue arrows to 
see related search 
options. 

• Click the magnifying 
glass to see the 
Substance Details in a 
separate window (called 
a Quick View). 
 

Click the reference title to 
go to the Reference Detail 
page, or click the 
magnifying glass to open 
the reference information 
in a Quick View window. 
 

2 

 
 

4 

6 

5 

Tip 
Click the Similar Reactions link to search for reactions 
based on the same reaction centers and similar structural 
characteristics. See the online help for more information. 

4 

5 

6 

Copyright © 2013. American Chemical Society (ACS). All rights reserved. 
This material is provided solely for the educational use of customers of Chemical Abstracts Service (CAS), a division of the ACS. Please provide attribution to ACS. 



On the Refine tab, click a 
radio button to select a 
Refine by: option. 
 
Below the radio buttons, 
further define the criteria 
by which you want to 
refine. 
 
Click Refine. 
 
The answer set is narrowed 
according to the criteria 
you specified. 
 

Refine to Narrow the Answer Set 

3 

1 
1 

2 

2 

3 

3 

4 
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Tip: Steps vs. Stages  
In many cases, a single step 
can have different stages. 
Stages occur when 
reagents are added 
sequentially, causing 
different reactions, but 
often without purification 
of intermediates. 

4 



Group by: Transformation groups single-step reactions based on 
transformation types so you can quickly evaluate synthesis 
options and preferred pathways. 
• Reactions can fall into more than one category.  
• Unclassified single- and multi-step reactions (if any) appear at 

the end of the answer set. 
 
Group by: Document shows all the reference titles for the 
answer set, and the total number of reactions associated with 
each title. 
 
 
 
 
 

Group by Document or Transformation 

4 

1 
1 

2 

Tip 
By default, answers are 
sorted by frequency. Click 
the drop-down arrow for 
other sort options. 

Tip 
Click the number of 
reactions to see just 
those reactions. 

2 
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Click the Analysis tab.  
 
Click the drop-down arrow 
to select an Analyze by: 
option. 
 
• Narrow results with 

bibliographic data using: 
• Accession Number 
• Company-

Organization 
• Document Type 
• Journal Name 
• Language 
• Publication Year  

 
• Narrow results with 

reaction data using: 
• Catalyst 
• Number of Steps 
• Product Yield 
• Solvent 

 
• Narrow results based on 

the availability of actual 
experimental details 
using:  
• Experimental 

Procedure  
 

Continued 

Analyze to See Subsets of Information 

5 

1 

2 
1 

Tip 
The top ten subsets appear on the Analysis tab. When additional subsets are available, click the Show More 
button at the bottom of the tab to see a complete list or to select more than one subset. 

2 
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Click an analysis bar to 
display only the answers in 
a subset. The selected bar 
turns yellow. 
 
The yellow status message 
indicates the new display. 
 
To replace the original 
answer set with the 
selected subset, click Keep 
Analysis. 
• To return to the original 

answer set, click Clear 
Analysis.  

 

6 

3 

3 

4 

4 

5 

5 

Tip 
Click      to see context-
specific, online help. 

Your answer set is divided into 
subsets based on the analysis 
criteria.  
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Click the Tools drop-down arrow and then 
click Find Additional Reactions. 
 
The message in the yellow status bar shows 
the number of additional reactions that 
SciFinder found. 
• These reactions appear at the end of the 

answer set. 
 
The synthesized compound is a product and 
appears to the right of the reaction arrow. 
 
The default Analyze of the new answer set is 
Answer Type. 
• Select  Additional Reactions to see only 

the newly added  reactions. 

Find Additional Reactions 

7 

1 
Find Additional Reactions takes advantage of the 
deep indexing in the CAplusSM bibliographic 
database. This feature identifies synthetically 
prepared substances in which the complete 
reaction information is not available but the 
reference indicates that the compound was 
synthesized.  See the Tip for more details. 
 

3 

1 

2 

3 

4 

4 
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Tip 
When authors do not provide complete reaction information for synthesizing a 
compound, these incomplete reactions cannot be put into the CASREACT® database.  

CAS scientists identify these substances and apply the Preparation CAS Role to the 
substance. This information is listed in the indexing of the CAplus bibliographic 
record. You can use Find Additional Reactions to see these synthesized substances.  



Click Save, Print or Export to open a dialog 
window and initiate each of these processes.  
See “How to… Print, Save and Export” for 
more information. 
 
The breadcrumb trail shows each step in your 
current search history. Mouse over a step to 
see more information about it. Click a step to 
return to that part of the search. 
 
Click Get References to retrieve references 
for part or all of your answer set.  
 
Click the Tools drop down arrow to access 
Find Additional Reactions and Combine 
Answer Sets. 
 
Click Send to SciPlanner to send selected 
answers to the SciPlanner workspace.  

 

Access Preferences and SciFinder Help options: Help, Training, What’s New and Contact 
Us. 
 
Click the Explore drop-down arrow to start a new references, substances or reactions 
search. 
 
Click the Saved Searches drop-down arrow to access Saved Answer Sets, Keep Me Posted 
answer sets, and your search History. 
 
Click SciPlanner to open the SciPlanner workspace.  
• SciPlanner is an interactive window where you can store and organize reference, 

substance, and reaction search results. Use it to gather information for a project, create  
a report, or export research to share with colleagues.  

• Three short videos about using SciPlanner are available the first time you open it and 
also in the online Help. 

Manage Your Searching 

CAS Customer Care Center 
Phone:  800-753-4227 (North America) Fax: 614-447-3751 
 614-447-3700 (Worldwide)    E-mail: help@cas.org 
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Find references quickly and easily 
In SciFinder, you are searching the world’s largest, publicly available reference database for chemistry and related sciences as well as MEDLINE® (the National Library of 

Medicine® (NLM®) journal citation database). Select from various reference search options, based on the information at hand and your research needs. This guide explains 

how to conduct each type of reference search.  When you have your answer set, refer to “How to … Work with Reference Answer Sets” for ways to evaluate the results and 

target the most relevant answers. For more detailed information about SciFinder, consult the online help or visit www.cas.org/training/scifinder. 

 

How to  Create a  
Reference Answer Set 

Types of Reference Searches 
On the Explore tab, under REFERENCES, you 
can search by any of the seven options.  
 
Click Advanced Search to see criteria for 
narrowing a search: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• These search limiters are available as part 

of the Refine and Analyze functions, so 
you can also apply them later in your 
search process. 

 
 

1 

1 

2 

2 

Tip 
For most keyword searches, it is often 
best to start with a broad search and 
narrow the results later. Use Advanced 
Search criteria to find specific references.  



To begin, click Research Topic. 
 
Enter your search concept(s) in the query 
entry text box. 
• A search concept, or keyword, is a term 

or phrase relevant to your topic of 
interest. 

• Enter up to seven concepts, separated by 
prepositions,  in English. 
• Recommendation: enter two or three 

concepts, separating each concept 
with a preposition. Use additional 
concepts to refine your answer set 
later. 

• Use “not” or “except” to exclude a term. 
 
Click Search.  
 

Continued 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 

Search by Research Topic 
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1 
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2 

3 

3 

Tip 
You can include up to three synonyms or acronyms for a concept. Place them in parentheses 
immediately following the concept and separate them with commas. E.g., cat (kitten, feline, 
felis catus) 
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Now what? 
After you click Get References, SciFinder will retrieve the answers which meet your query requirements. To learn about 
working with the answers, please see the companion document titled, “How to… Work with Reference Answer Sets.” 

 
 
Select the answer set that 
you want to use from the 
list. 
• Click the box to select  

an option. A green 
checkmark indicates it 
has been selected. 

 
Click Get References. 
 
 

 
 
 
 

 
 

3 

4 

SCIFINDER CONSIDERS TERMS TO BE...  WHEN THE TERMS ARE FOUND...  

"As entered"  Exactly as you have entered them.  

"Closely associated with one another"  Within the same sentence or title.  

"Present anywhere within a reference"  Anywhere (perhaps widely separated) within a record's title, 
abstract, or indexing.  

"Containing the concept"  Somewhere in the record.  

4 

5 

Tip 
All  concepts “present 
anywhere in the reference” 
is often a good starting 
point. If the number of 
references is too large or 
you find many non-relevant 
references, consider 
selecting the narrower 
option in which all of the 
concepts are “closely 
associated with one 
another.”  

5 

SciFinder returns a set of Topic 
Candidates. 
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To begin, click Author Name. 
 
Enter as much of the name as you know.   
• Only the Last name is required. Include 

the First and Middle names or initials to 
improve the search results. 

• Enter punctuation (spaces, hyphens, etc.) 
as if you were writing the name.  

• Replace special characters with 
equivalent character(s), e.g., ae replaces 
ä. Consult the  online help for more 
information about special characters. 

• For optimal retrieval, “Look for 
alternative spellings of the last name” is 
selected by default. 

 Click Search. 
 
SciFinder returns a list of authors. The 
number of references associated with each 
name appears on the right. 
• Click the box next to any name(s) you 

want to select. A green checkmark 
appears. 

 
Click Get References. 
 
 

Search by Author Name 
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Tip 
Create a Keep Me Posted (KMP) automatic 
alert if you want to know when new records 
for this author are added to the database. 
See the “Create and Manage Alerts (KMPs)” 
guide for more information. 

4 
4 

5 5 

Now what? 
After you click Get References, SciFinder will retrieve the answers which meet 
your query requirements. To learn about working with the answers, please see 
the companion document titled, “How to… Work with Reference Answer Sets.” 

Tips 
• For complicated names, try multiple 

searches and determine which 
search gives the best results.  
• Under the Tools drop down, you 

can also combine answer sets.  

Copyright © 2013. American Chemical Society (ACS). All rights reserved. 
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To begin, click Company Name. 
 
Enter the name of one organization into 
the query entry text box. 
 
Click Search. 
 

Search by Company Name 
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Now what? 
After you click Search, SciFinder will retrieve the answers which meet your query requirements. To learn about 
working with the answers, please see the companion document titled, “How to… Work with Reference Answer Sets.” 

Company Name Searching Guidelines 
• SciFinder considers various spellings, acronyms, abbreviations, and related terms when 

retrieving results. It does not consider  mergers and acquisitions. 

• SciFinder automatically searches common synonyms and abbreviations. For example, 
entering “Company” or “Co.” returns the same results. 

Tip 
To see all of the name variations 
that SciFinder considered, analyze 
the answer set by 
Company/Organization. See “How 
to … Work with Reference Answer 
Sets” for more details. 
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To begin, click Document Identifier. 
 
Enter up to 25 identifiers, one per line, in 
the query entry text box. 
 
Click Search. 
 
 

Search by Document Identifier 
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Now what? 
After you click Search, SciFinder will 
retrieve the answers which meet your 
query requirements. To learn about 
working with the answers, please see the 
companion document titled, “How to… 
Work with Reference Answer Sets.” 

Searchable Document Identifiers  
TYPE OF IDENTIFIER EXAMPLE 

Accession number: A unique number applied to a record when it is put into the 
database. It begins with the year that the document entered the database. 

CAplus: 2012:1527010  
MEDLINE: 1998010009 

Document number: A sequential identification number that is assigned to a 
document (before the document enters the database). 

CAplus: 107:12935 
Medline: 22893704 (also called a 
PubMed ID number) 

Digital object identifier (DOI): an alphanumeric character string that uniquely 
identifies an electronic document over the course of its lifetime. 

10.1021/jp204843r 

Tip 
SciFinder ignores punctuation and 
accepts both two-digit and four-digit 
formats for years. Therefore, the 
search term 1983:4296 will retrieve 
both the PubMed ID 834296 and the 
CAplus Accession  Number 
1983:4296. Select the document of 
interest when you review the 
answers. 
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To begin, click Journal. 
 
Enter a Journal Name (required).  
• Enter data in the additional fields to 

retrieve more specific answers. 
 
Click Search. 
 
 

Search by Journal 
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Now what? 
After you click Search, SciFinder will 
retrieve the answers which meet your 
query requirements. To learn about 
working with the answers, please see the 
companion document titled, “How to… 
Work with Reference Answer Sets.” 

FIELD DATA ACCEPTED 
Journal Name • Full name, abbreviation, or acronym 

• Abbreviations or acronyms must not contain spaces or punctuation 
• Maximum of 30 characters 

Volume Number (38) or alphanumeric string (45a) 
• A Journal Name must be specified before a Volume, Issue, or Starting Page 

can be recognized 
Issue Number (16) or month (June) 
Starting Page Number (46), letters (iii), or alphanumeric string (m287) 
Title Word(s) Key words, a partial title or a full title 

Tip 
Create a broad search by using title words, 
only a journal name or only a last name. 
Narrow search results by using a full title, 
the journal name, issue and starting page, 
the author’s full name, or a combination of 
these items. 
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To begin, click Patent. 
 
Enter a Patent Number.   
• Acceptable patent numbers include any 

number that identifies a patent, such as 
patent application numbers, priority 
application numbers, and patent 
numbers. 

 
 
 
 
 
 
 
 
Alternatively, you can enter an Assignee 
Name or Inventor Name. 
• Enter data in several fields to create a 

narrower search. 
 
Click Search. 
 

Search by Patent 
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Tip 
One number can retrieve both a granted patent and an unrelated patent application. You can 
easily select the record of interest while reviewing the search results. 

Now what? 
After you click Search, SciFinder will retrieve the answers which meet your query requirements. To learn about 
working with the answers, please see the companion document titled, “How to… Work with Reference Answer Sets.” 

TYPE OF IDENTIFIER EXAMPLE 

Patent Application Number WO 2012-US29090 
 

Priority Application Number US 1996-15450P 
 

Patent Number JP 2001519650 
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A tag is a user-defined keyword that you can 
apply to references in one or more answer sets.  
When you save an answer set, the tag is saved 
with the associated reference. Search a tag to 
retrieve any references to which the tag was 
applied.   

To begin, click Tags. 
 
From the displayed list, select the tag that 
you want to search. 
 

Search by Tags 
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Tip 
Search a tag to create a 
new answer set that 
contains documents from 
different answer sets 
that have the same tag.  

Now what? 
After you click a keyword, SciFinder will 
retrieve the answers which meet your 
query requirements. To learn about 
working with the answers, please see the 
companion document titled, “How to… 
Work with Reference Answer Sets.” Tip 

When reviewing your search You can apply tags to records results by 
selecting Add Tag from the Tools menu. In the dialog box, enter the 
key word(s) that you want to apply as a tag. After they are created, 
tags become searchable. 
 
 
 

SciFinder retrieves all of the records to which 
that tag has been applied. This feature allows 
you to pull references from several different 
answer sets and place them all into a new 
answer set . 
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Start a new References, Substances or Reactions search. 
 
Access Saved Answer Sets, Keep Me Posted automated alert results, and your search 
History.  
 
Open the SciPlanner interactive workspace where you can organize your reference, 
substance and reaction search results. 
 
 
 
 

Manage Your Searching 

CAS Customer Care Center 
Phone:  800-753-4227 (North America) Fax: 614-447-3751 
 614-447-3700 (Worldwide)    E-mail: help@cas.org 10 July 2013 

1 2 

Tip: Other Ways to Create a Reference Answer Set 
• You can also create a reference answer set by starting with a reaction or substance search. After you 

get a reaction or substance answer set, just click the “Get References” icon at the top of the page. 
 
 
 
 

 
 

3 

2 

1 

3 

4 

Access Preferences and SciFinder Help 
options:  Help, Training, What’s New and 
Contact Us. 
 
Click Save, Print or Export to open a dialog 
window and initiate these procedures.  

4 

5 

5 



By default, references in your answer set  
are sorted by Accession  
Number. Click the  
drop-down arrow  
for other sort options. 
 
• The blue arrow indicates the sort order 

(e.g., newest to oldest or alphabetical). 
Click the arrow to reverse the order. 

 

Below the Sort by options, the number of 
references in the answer set and the number 
that have been selected are displayed. 
• Click the blue drop-down arrow to select 

all of the 
 answers. 

 
 
 

• To select individual answers, click the box 
to the left of an answer number.  

 

Specify the number of answers displayed per 
page. 
 

Continued 
 

How to  Work with a 
Reference Answer Set 

Reference Search Results 

Easily identify and isolate references of interest 
Quickly retrieve relevant information from the world’s largest, publicly available reference database for chemistry and associated sciences. This guide provides an overview 
of some of the sort, refine, and analyze tools for confidently evaluating and narrowing even a large answer set. From there, a single click retrieves substances or reactions 
associated with your references.  For more detailed information and additional training resources, consult the online help or visit www.cas.org/training/scifinder. 

1 

2 

3 

3 1 
2 

Tip 
An Accession Number is a unique identifier given to a record when it is entered in 
the database. In the CAplusSM database, it begins with the year in which the record 
is put into the database, followed by a colon and sequential numbering. 



Three Display options are available: 
• One bar shows the bibliographic 

information. 
• Two bars shows the bibliographic 

information and a partial abstract. It is 
the default, shown here. 

• Three bars shows the bibliographic 
information and the full abstract. 

 
Use the page controls to navigate through 
your answer set.  

 
The magnifying glass is a link to a “Quick 
View.”  Click it to open a new window that 
contains the reference details. Close the 
window to return to your active session. 
 
Click the Full Text link to launch the CAS 
Full Text Options page (not shown). 
 
Click the molecule icon to see the 
Substances indexed for a document (not 
shown). CAS analysts identified these 
substances as being important to the 
science reported in the document. 
 
Click the Citings icon to retrieve the 
documents that have cited this reference. 
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Tip 
With the Full Text link, European and US patents are often immediately available 
via Espacenet. If your company purchases journal subscriptions, your Knowledge 
Center or SciFinder Administrator can set up the CAS Full Text Options page to let 
you immediately access records from those journals from your desktop. 

4 
4 
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Click the Refine tab and click 
a radio button to select a 
Refine by: option. 
 
Specify additional criteria 
below the refine options. 
• Here, the answer set is 

refined to include 
answers with two 
additional concepts. 

• A synonym is included  
in parentheses.  
 

Click Refine. 

Narrow an Answer Set with Refine Options 
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The Answer Set is Narrowed to 236 References 

Tips 
• SciFinder automatically searches for both 

singular and plural forms of a word (method; 
methods), alternate word endings and forms 
(clean; cleaning), and common synonyms 
(ocean; sea; marine) to save you time and 
increase comprehensiveness. 

• When searching or refining by Research 
Topic, you can include up to three synonyms, 
separated by commas and enclosed in one 
set of parentheses. 

• When you refine by Research Topic, both the 
old and new hit terms are highlighted in the 
title and are bolded in the abstract. 



Click the Analyze tab. By 
default, the answer set is 
analyzed by Author Name. 
 
Click the drop-down arrow 
to see the available 
Analyze by: options.  
 
Click Show More to see 
additional data when it is 
available (see inset), or to 
select more than one 
analysis subset. 
• E.g., it is useful when 

you want to select 
several variations of an 
author’s name. 

 
Continued 

 
 

Evaluate Answers with Analyze Options 
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Tip 
Some document types 
are listed in all capital 
letters. These subsets are 
unique to MEDLINE® (aka 
PubMed). The 30 
JOURNAL ARTICLE(s) in 
MEDLINE are also 
included in the Journal 
subset which contains the 
documents from both 
MEDLINE and CAplus. 



 
Click an analysis bar to 
display that subset of 
answers. 
• Parts of other analysis 

bars turn yellow if any 
records fall into more 
than one subset.  

 
The yellow status bar 
indicates the answers that 
are currently displayed. 
• Click Keep Analysis to 

make these answers 
your new answer set. 

• Click Clear Analysis to 
return to your original 
answer set. 

 
Or, select a different subset 
on the Analyze tab to view 
those records. 

Narrow an Answer Set after Analyzing 
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Here, the answer set has been 
analyzed by Document Type. 

Tip 
The Analyze capability is an effective way to learn more about your results because you can use Clear Analysis to 
return to the original answer set. After you have explored the answer set several ways, you can then decide how 
you want to narrow it, make that selection, and then click Keep Analysis or choose to narrow the answer set 
using other techniques. 



When you click the blue title of a 
reference in your answer set, the 
Reference Detail is displayed. 
 

Reference Detail 
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At the top, the title, authors, 
and abstract are shown. 
 
For patents, below the 
abstract you will see the 
Patent Information table. 
• The Priority Application 

is the first application 
filed with a patent office. 

• WIPO patents will always 
list the WO patent 
application number as 
well as the first country 
where the patent 
application was filed. 

 
On the right are details 
about the publication 
Source, the associated 
Company/Organization, the 
Accession Number, the 
Publisher and the original 
Language (after 1967). 

 
Continued 



CAS scientists extract key scientific terms 
and concepts from each document. This 
Indexing is added to each reference. 
• Each of the 80 Chemical Abstracts Section 

codes covers one broad scientific 
discipline. 

• The Concepts are standardized, uniform 
index terms.  

• Substances are the chemical compounds 
critical to the science of the document. 

• Supplementary Terms are relevant 
keywords for that document. They are 
not controlled vocabulary.  
 

Below the Indexing are the Citations for the 
document.  
• If the citation is blue, you can click it to 

see the database record for that 
reference.  

 
You can apply or Edit Tags to documents 
here.  
• You can search Tags. This feature allows 

you to combine records from many 
answer sets into one answer set. 

• You can also add a tag (up to 500 records) 
under the Tools button on the toolbar. 

 
You can add Comments to individual records 
as reminders about important information or 
as project identifiers. 
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Tip 
In the Concepts and Substances 
Indexing, some of the items are blue, 
indicating that they are a link. If you click 
a link, then SciFinder conducts a search 
on that concept or for that substance. 

8 
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Select a Category Heading. 
 
Select a Category of 
interest. 
 
Select one or more Index 
Terms by clicking the box 
to the left of a term. 
 
In the Selected Terms 
summary box, click the 
blue circle with the white 
“X” to delete a term. 
 
Click OK to narrow your 
search based on the 
selected index terms. 

Use Categorize to Identify Specific Records 
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Tip 
Add Index Terms to your search query. Begin with a broad research topic search. In the answer set, find a 
couple records that are very relevant. Look at the index terms for those documents. Then, re-run the search 
with these index terms added to your search query. 
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CAS scientists identify key terms 
and concepts that they include in 
the indexing of each database 
record. These index terms are 
standardized and uniform to 
describe the science in the 
original document. 
 
Categorize lets you find the 
references associated with 
selected indexing. 
 
Click the Categorize button to 
launch the Categorize window. 

1 2 3 4 
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Access Preferences and SciFinder Help options: Help, Training, What’s New and Contact Us. 
 
Click the Explore drop down arrow to start a new references, substances or reactions search. 
 
Click the Saved Searches drop-down arrow to access Saved Answer Sets, Keep Me Posted 
answer sets and your search History. 
 
Click SciPlanner to open the SciPlanner workspace.  
• SciPlanner is an interactive window where you can store and organize reference, 

substance and reaction search results.  
 

Click Save, Print or Export to open a dialog window and initiate each of these processes.  
• See “How to… Print, Save and Export” for more information. 
 
The breadcrumb trail shows each step in your current search history. Mouse over a step to 
see more information about it. Click a step to return to that part of the search. 
 
Click Get Substances to retrieve substances for part or all of your answer set.  
 
Click Get Reactions to retrieve reactions for part or all of your answer set. 
 
 
 
 
 
 
 

 
Click Get Related Citations to Get Citing or 
Get Cited references. 
 
Click Get Full Text to launch CAS Full Text 
Options. 
 
Click the Tools drop-down arrow to access 
Remove Duplicates, Combine Answer Sets 
and Add Tags. 
 
Create Keep Me Posted, when active, allows 
you to create an automated alert based on 
the current search strategy.  
• See “How to… Create and Manage KMP 

Alerts” for more information. 
 
Click Send to SciPlanner to send selected 
answers to the SciPlanner workspace. 
• Use it to gather information for a project, 

create a report or export research to 
share with colleagues.  

Manage Your Searching 

CAS Customer Care Center 
Phone:  800-753-4227 (North America) Fax: 614-447-3751 
 614-447-3700 (Worldwide)    E-mail: help@cas.org 
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How to  Create  
and Manage Alerts  

Create a Keep Me Posted (KMP) Alert 

When the Create Keep Me Posted Alert 

button is present, you can create an 

automated KMP alert based on your 

search. 

 

 

 

Automatic notifications keep you up-to-date on the latest developments in your field.  
After you create a substance or reference answer set, you can be notified automatically when new records on your search topic are added to the database. Track 

competition, monitor patents or conduct business analysis with this convenient feature. Additional information about Keep Me Posted alerts is available in the online help 

or in additional training materials at www.cas.org/training/scifinder. 

 

1 

1 

SciFinder searches databases that are updated 

daily. You can set up a KMP alert so that you 

never miss important, new information. To begin, 

conduct a search on your topic of interest. 

In the following example, the alert is created for a 

reference search. The same Create Keep Me 

Posted Alert option is also available if you want to 

be notified about new data related to substance 

searches. 

Continued 

Tips 

The KMP button will not be active if 

your search strategy includes steps 

that cannot be included in a KMP. 

Such steps include Analyze and 

Categorize. Consult the online help 

(   ) for details. 

1 



Enter a Title for your KMP profile.   

 

(optional) Enter a Description. 

 

The Duration of the profile is automatically 

set to one year from the date it is created.  

To change the duration, click Change and 

select the desired timeframe. 

 

 

 

 

 

 

Specify how often you would like 

notifications to be sent: weekly or monthly.   

 

 

 

 

 

If you select weekly, you will be notified 

when the bibliographic information for the 

record is first entered into the database 

and again when the indexing (substances 

and scientific vocabulary) is added.  

• Click the checkbox to Exclude previously 

retrieved references if the indexing is 

not relevant to your research needs. 

 

Click Create. You are then returned to your 

active session.  
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Tips 

• If you are interested in timely patent information, then a SciFinder KMP can help to 

keep you updated. Bibliographic information from nine major patenting authorities 

is entered into the CAplusSM database within two days of being issued. CAS scientists 

have up to 27 days to add the keyword and substance indexing to the record. 

• Substance alerts do not include stereo, precision or similarity candidates.  
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Find the document of 

interest. 

 

Click the Citings icon 

located to the right of the 

title. 

 

After the citing references 

appear, click Create Keep 

Me Posted Alert. 

 

Complete the Create the 

Keep Me Posted Profile.  

• Whenever the original 

document is cited, then 

you will get an alert 

about it. 

• After you complete the 

profile, you are 

returned to your active 

session. 

 

Follow Citings Using a KMP Alert 
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4 

You can create a KMP alert to 

automatically receive a 

notification whenever a 

specified document is cited.  
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Tip 

The yellow status message about 

excluding a step in the profile 

indicates that the KMP does not 

provide a candidate list of references. 

See How to… Create a Reference 

Answer Set for more information. 



Click Preferences in the upper right corner  

of the SciFinder window. 

 

Check the box to receive e-mail notifications. 

• Make sure your e-mail address is correct 

by clicking the myCAS link.  

 

Click OK to save your Preferences. 

 

The KMP results e-mail will contain 

hyperlinks for up to the first ten new titles  

or substances. Click a hyperlink to sign into 

SciFinder and open the record. 

 

 

Set KMP Preferences  
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Tip 

myCAS provides access to your 

contact and sign in information. 

You can log into myCAS using your 

SciFinder login ID and password.  

You can set your Preferences to receive an  

e-mail whenever a new KMP result is available 

or an existing alert is about to expire.  
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Tip 

If your alert finds more than ten results, 

sign in to SciFinder to see all of them. 

4 



Access KMP Results  

5 

1 

2 

You can access KMP results in two ways. 

On the right side of any Explore 

window: 

• Click a date to open the answers 

received on that date.  

• The number of records found on 

that date is shown in 

parentheses. 

 

Click Keep Me Posted on the Saved 

Searches tab.  

• Click a date to open the answers 

received on that date.  

 

 

 

 

 

In the Keep Me Posted window, 

select the answer sets you want to 

merge together. 

 

Click Combine and in the dialog 

window, select the combine both 

sets option.  

 

 

The combined answer set will open 

in SciFinder so that you can review 

the answers. 
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4 

4 

To review answers found on multiple 

dates simultaneously, merge them into a 

single answer set. 
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To review your current awareness 

profiles and results, go to the 

Saved Searches drop-down menu 

and select Keep Me Posted. 

 

In the Keep Me Posted window, 

you can see the status of all your 

alerts.  

 

To change a profile, click Edit, 

located to the right of the profile 

title. 

 

Change the title, description, 

status, duration and/or frequency 

of your alert. 

 

Click Edit at the bottom of the 

dialog box to save the changes. 

 

Edit KMP Alerts 
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Tip 

To change the expiration date of 

an alert that is about to expire, 

use Edit. On the Keep Me Posted 

page, SciFinder also sends you a 

yellow status message when an 

alert is about to expire. This 

message includes a link that says 

Extend 12 Months. 
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How to  Save, Print 
and Export Answers 

Save, Print and Export: General Information 
Save, Print or Export reference, substance and 
reaction answer sets.  

Keep your SciFinder answers for future use 
Keep answer sets for future use with print, save, and export capabilities. To generate a hardcopy of part or all of your answer set, use Print to create a .pdf file that can be 

viewed, saved and printed. Save your answers to the SciFinder server for future use  or Export answers to your computer to use with other software applications or to share 

with colleagues. To access additional training resources on this and other topics, consult the online Help or visit www.cas.org/training/scifinder. 

1 

2 

By default, all answers are saved, printed or 
exported.  
• An option to save, print or export only 

selected answers is available.  
• To select answers, click the box to the 

left of an answer number. 
 
In the upper right , click Save, Print or 
Export to launch a dialog window.  
• The options in the dialog window will 

vary depending on the type of answer 
set and whether you are saving, printing 
or exporting. 

 
 

1 

2 

The following pages show examples of printing, 
saving and exporting answer sets. 



Click Save, located in the upper right.  
 
In the Save This Answer Set window, select 
the answers to save, enter a Title and enter 
an optional Description.  
 
Click OK to save the answers.  
 

Save Reactions Example 

2 

1 

1 
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3 

Use Save to place a file of your reference, 
substance or reaction answers on the SciFinder 
server. The answers are saved with your 
SciFinder login ID so that you can access them 
from any computer.  
 
 
 

Tip 
For a single answer set, you can save up to 
20,000 answers of any type.  

2 

3 

The Save This Answer Set dialog window closes 
and you are returned to your active session. To 
place answers on your own computer or 
network, use Export. 
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On the top navigation bar, click Saved 
Answer Sets to open the Saved Answer 
Sets dialog window.  
 
Saved reference, substance and reaction 
answer sets are available on separate tabs.  
You can click: 
• A title to re-open the answer set. 
• Edit to make changes to the title or 

description. 
• Link to create a link that you can 

bookmark for quick access or send to  
colleagues who can open the answer set 
in SciFinder. 

• A checkbox and then Delete Selected to 
remove a saved answer set. 
 

If you select two or more answer sets, then 
the Combine Answer Sets button becomes 
active. Click it to open the corresponding 
window. 
 
You can combine two answer sets in one of 
four ways. Select the combine option of 
interest. 
• If you select more than two answer sets, 

then only the Combine and Intersect 
options are available. 

 
Click the Combine Answer Sets button. The 
answers are merged and become your 
active session. 
 
 

 
 
 

Work with Saved Answer Sets 
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3 

Click the drop-down arrow on the Saved 
Searches tab to access all of your Saved 
Answer Sets, Keep Me Posted alert 
results, and your search History. 
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You can print references, substances and reactions. To 
begin, click Print in the upper right. 
 
In the Print dialog window: 
• Select the answers you want to print: All, Selected, or a 

Range. 
• In the Format section, click a radio button to select the 

parts of the record that you want to print. 
• Enter a Title. 
• If desired, specify additional information to Include 

with your answer set (options vary depending on the 
type of answer set). 

 
Click Print to generate a .pdf file that downloads or opens 
in a separate window, depending on browser settings.  

4 

Print References Example 
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3 The PDF document 



Click Export in the upper right. 
 
Specify  the answers to Export.  
 
Specify the file format. 
• See the table for descriptions of 

commonly used formats. 
• The file formats and options vary, based 

on the type of answer set you have. 
• Consult the online SciFinder Help for 

additional information about exporting 
data. 

 
Under Details, specify a File Name, and,  
optionally, Annotation. 
• The options in this section vary 

depending on the file format you select. 
 
Click Export. The file is placed into your 
download folder. You are returned to your 
active session. 

Export Substances Example 

5 

Export answers for use with other software 
applications or to collaborate with a colleague. 
When you export, the file is stored on your 
computer.  

Tip 
The file types and details that can be saved 
vary, depending on whether you are exporting 
references, substances or reactions. Refer to 
the online Help for more details. 

FILE FORMAT PURPOSE 
.ris To export references for use with citation management software (check your 

application to confirm which file format to use) 
.akx To export data for collaboration with other SciFinder users 
.sdf  To export structures and substance identifiers to a file format readable by some 

molecule database programs; structures are represented in molfile format 
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5 To store the file on the SciFinder server, use Save. 
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